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GLOSSARY AND ACRONYMS
CHAPTER 1 GENERAL

General

This document describes the usage of the MX-ONE Service Node (SN) packed as a Virtual Appliance for
VMware vSphere/ESXi.

If an existing MiVoice MX-ONE system has used Turnkey Solution installation (with hardware), and shall
be changed into a Virtual Appliance installation, that has to be done as a new installation with Virtual
Appliance.

Glossary and Acronyms

For a complete list of abbreviations and glossary, see the description for ACRONYMS, ABBREVIATIONS
AND GLOSSARY.
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CHAPTER 2 PREREQUISITES

Prerequisites

e The vSphere Client installed on a workstation.

*  VMware ESXi 5.5 host (minimum version 5.5) or a vCenter solution, recommended version is VMware
ESXi 6.5.

* The MX-ONE Service Node Virtual Appliance file.
» Good knowledge of VMware vSphere.
* Good knowledge of SLES12 and MX-ONE installation.

» Read the MiVoice MX-ONE SYSTEM PLANNING description, and the description VIRTUALIZATION
FOR MIVOICE MX-ONE 7.0 or later.

NOTE: For database (Cassandra) server VMs, co-located or stand-alone, SSD disks are required.
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CHAPTER 3 EXECUTION

Execution

The procedure involves the following 3 major tasks:
1. Importing the Virtual Appliance to:

— a single ESXi host, or

— a vCenter cluster

2. Post-configuring a newly imported MX-ONE virtual machine

3. Installing and Configuring MX-ONE
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IMPORTING ON A SINGLE ESXI HosT (FRom ESXI 6.5)
CHAPTER 4 IMPORTING THE VIRTUAL APPLIANCE

Importing the Virtual Appliance

This section describes how to install the MX-ONE Service Node Virtual Appliance on a virtual machine.

Importing on a Single ESXi Host (From ESXi 6.5)

This section describes how to install the MX-ONE Service Node Virtual Appliance on a single VMware
ESXi host through the VMware host client. This scenario applies to the free version of ESXi.

1. Log in directly to the ESXi host through the VMware Host Client (via Web browser enter the IP
address/FQDN of the ESXi host).

2. Click Host and from the main menu, select Create/Register VM. A wizard opens that will assist in the
deployment process. in the first step, select the Creation Type and select Deploy a virtual machine
from an OVF or OVA file.

3. On the next page, specify a name for the virtual machine and select the OVF and VMDK files or the
OVA for the VM you want to deploy.

4. Select a data store for the virtual machine. It could be either local or centralized (SAN).

5. Map the networks used in this OVF to networks in your inventory, select disk format for the virtual
disks. Thick provisioning allocates all space at once, thin allocates on demand. Thick gives a slight
performance gain and eliminates the risk of over-shooting actual storage space.

6. You will get a summary page to review your settings selection before you exit the wizard and proceed
to start the deployment.

7. Click Finish to start the deployment task.

Importing on a Single ESXi host (From ESXI 6.0 Or Earlier)

This section describes how to install the MX-ONE Service Node Virtual Appliance on a
single VMware ESXi host through the vSphere client. This scenario applies to the free

version of ESXi.
1. Log in directly to the ESXi host through the vSphere client.
2. From the File menu, select Deploy OVF Template....

3. A wizard opens that will assist you with deployment process. In the first, select the Virtual Appliance
file. Next page shows some information about the Virtual Appliance.

Specify a name and location for the deployed template.
Select a data store for the virtual machine. It could be either local or centralized (SAN).
Select thick lazy zero provisioning as the disk format for the virtual disks.

Map the networks used in this OVF to networks in your inventory.

© N o o A

All done - click Finish to start the deployment task.
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IMPORTING INTO A VCENTER CLUSTER
CHAPTER 4 IMPORTING THE VIRTUAL APPLIANCE

Importing into a vCenter cluster

This section describes the import process of a MX-ONE Service Node Virtual Appliance in a VMware
vCenter cluster environment.

Such an environment contains multiple hosts, centralized storage, and distributed network and supports

the vCenter features such as vMotion, High Availability (HA), and Fault Tolerance (FT).

1. From the vSphere client or vSphere Web client, log on to the vCenter server.

2. Ifyou are importing on a vSphere client, select from the File menu and select Deploy OVF Template....
A wizard opens that guides you through the deployment process.Select the Virtual Appliance file to
import.

3. A page opens showing information about the Virtual Appliance.

a. Select the Virtual Appliance file to import. A page opens showing information about the Virtual
Appliance.
b. Enter a name for the virtual machine, and also, select the datacenter where it should be used.

c. Select the host or cluster that should handle the new virtual machine. A review page with data
about the Virtual Appliance is displayed.

4. If you are importing on a vSphere Web client, right- click on the vCenter server and select Deploy OVF
Template.... A wizard opens that guides you through the deployment process.

a. Select the Virtual Appliance file to import.
b. Enter a name for the virtual machine, and also, select the datacenter where it must be used.

c. Select the host or cluster or resource pool or vapp where to run the new virtual machine. A review
page with data about the Virtual Appliance is displayed.

5. Select datastore for the virtual machine. Choose a centralized storage (SAN) if HA/FT will be used.

6. Select the virtual network the virtual machine must connect to. In a clustered environment, this is
normally a Distributed Switch. Be sure that switch is connected to the production/telephony network

7. Select the disk format for the virtual disks. If FT will be used, or thick provisioning must be selected.
For other cases, select any format (you can keep the default selected).

8. Select the virtual network the virtual machine must connect to. In a clustered environment, this is
normally a Distributed Switch. Be sure that switch is connected to the production/telephony network

9. With this all, necessary information is now collected. Click Finish to start the deployment task.

After you finish importing a Virtual Appliance by using a single ESXi host or a vCenter cluster, you will
have a MX-ONE Service Node in turnkey state. At this moment, the server is not yet configured and is
generic (it has not yet been assigned any specific function). Starting up the virtual machine triggers the
turnkey installation process, which is identical to the one used for physical MX-ONE servers. If more than
one MX-ONE Service Node is needed, just run the process above multiple times using the same Virtual
Appliance file. Give each virtual machine an unique name and distribute them over the hosts in the cluster
(how depends on the cluster setup, the amount of servers inside the cluster and the load on the hosts)
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CHAPTER 5 POST-CONFIGURATION OF A NEWLY IMPORTED MX-ONE VM

Post-Configuration of a Newly Imported
MX-ONE VM

Before using a newly imported MX-ONE virtual server, some settings must be considered and maybe
changed. These are mainly related to processor and memory allocation

» Hardware - Memory

The amount of memory the virtual machine is equipped with. The value must be changed according to
the system size and the MX-ONE application that the server will run, e.g. Service Node, Service Node
Manager, Database (Cassandra), Provisioning Manager and Media Server. For configuration and plan-
ning of virtualization, see the description VIRTUALIZATION FOR MIVOICE MX-ONE 7.0 or later.

» Hardware - CPU

By default, two CPUs are allocated to the virtual machine. If you plan to use Fault Tolerance together with
the MX-ONE Service Node, this must be changed up to 8 vCPUs. Also, numbers of CPUs needed in a
server depends on desired performance and system size. For configuration and planning of virtualization,
see the description VIRTUALIZATION FOR MIVOICE MX-ONE 7.0 or later.

« Options - Paravirtualization

This must be disabled on Fault Tolerance-enabled virtual machines as it is not supported. On all other
configurations, keep this enabled.

* Resources - CPU

This setting affects the resource allocation in the cluster/host. This must be configured to match required

performance of the MX-ONE and the capacity of the cluster/host and how many virtual machines are
running in parallel.

» Resources - Memory

As for the CPU-resources, this setting depends on the capacity needed, the cluster/host configuration and
how many other virtual machines are running in parallel.

» Disks

For database (Cassandra) server VMs co-located or stand-alone, SSD disks are required.

NOTE: Be sure that the network configuration of the virtual machines is properly set up in the cluster. By
default, the standard "VM Network" is used. In a cluster environment where distributed switches are used
(a requirement if HA/FT is used), this must certainly be changed.
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

Installing MX-ONE on Hyper-V

The Microsoft hardware virtualization product, Hyper-V lets you create and run a software version of a
computer, called a virtual machine. Each virtual machine acts like a complete computer, running an oper-
ating system and programs. The following are the requirements of the virtual machine.

* It can be installed on Windows Server (2008, 2012, 2016)

» It requires only a Windows license and no specific license is required.

» Windows Server can be installed on a Dell or an HP server.lt is similar to VMware in its functioning.
* It uses .vhd and. vhdx format image for installation.

To install MX-ONE on a Hyper-V setup:

Once the Windows Server get successfully installed,
1. Enable Hyper-V using PowerShell.
a. Open a PowerShell console as Administrator.

b. Run Enable-WindowsOptionalFeature -Online -FeatureName Microsoft-Hyper-V
-A11 command to install Hyper-V.

EN Administrator: Windows PowerShell - O *

soft Corporation. A1l rights reserved.

» Enable-WindowsOptionalFeature Mi crosoft-Hyper-V
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

Server Manager * Dashboard

WELCOME TO SERVER MANAGER

0 Local Server

& All Servers

- , 0 Configure this local server
W File and Storage Services b =

B Hyperv QUICK START
B Add Roles and Features Wizard — O .
DESTINATION SERVER
Select server roles WIN-35MLI7LAMDG

Before You Begin Select one or more roles to install on the selected server.

Installation Type Roles Description

Server Selection [:.ctivc Directory Certificate Service: A Active Directory Certificate Services

] Active Directory Domain Services (AD CS) is used to create

p— [ Active Directory Federation Services certification authorities and related
- [] Active Directory Lightweight Directory Services role services that allow you to issue
[] Active Directory Rights Management Services and manage certificates used in a
[] Device Health Attestation variety of applications.
[] DHCP Server
] DNS Server
[ Fax Server
I [®] File and Storage Services (1 of 12 installed) _
[] Host Guardian Service Manageability
| Hyper-V (Installed) Events
] MultiPoint Services
[] Network Policy and Access Services I Services
[] Print and Document Services
] Remote Access Performance
[] Remote Desktop Services
[ Volume Activation Services BPA results
] Web Server (IIS)
[] Windows Deployment Services
1/29/2019 123 AM
Install
T Server Manager
Server Manager * Dash -
WELCOME TO SERVER MANAGER
§ Local Server
All Servers .
. i Configure this local server
% File and Storage Services b 2
BB Hyper-v QUICK START
2 Add roles and features
3 Add other servers to manage
WHAT'S NEW
4 Create a server group
5 Connect this server to cloud services
LEARN MORE
ROLES AND SERVER GROUPS
Roles:2 | Servergroups:1 | Servers total: 1
= File and Storage
] 2
¥ Services ! i HyperV 1
(@ Manageability (@ Manageability (@ Manageability (@® Manageability
8 Hyper-V Manager T T T o - X
Fie Action View Help
ez
[ Hyper-V Manager - - Actions
g WiN-35MLITLAMDG R e CEr o
Name State CPUUsage  Assigned Memory  Uptime Status Configurati.. " R
ew

No vitual machines were found on this server [ Import Virtual Machine,

[ Hyper-V Settings..

g3 virtual Switch Manager...
4. Vittual SAN Manager.
i EditDisk..

5 Inspect Disk.
) Stop Senvice
% Remove Server
U Refresh

View »

Help
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

2. Before you install, create a Virtual Switch Manager for Hyper-V to give network access to the virtual
machines.

3. Select Virtual Switch Manager from the right pane.
EE Hyper-V Manager - X
eslamum

[ Hyper-v Manager - - Actions
[ WIN-35MLITLAMDG VST

WIN-35MLITLAMDG -
Name State CPUUsage  Assigned Memory  Uptime Status Configurat
New >
No vitual machines were found onthis server. By Import Virtuel Machine

Hyper-V Settings.

=o

Virtual Switch Manager.
4. Virtual SAN Manager..
4 Edit Disk.

& Inspect Disk.
m) Stop Service
X Remove Server
© Refresh
View >

H Help

4. Select the type of switch, in this case, an External Switch.
B& Hyper-v Manager ) . M
e s B

A Hyper-V Manager - - ‘Actions
[l WIN-35MLITLAMDG R i T
Name State CPUUsage  Assigned Memory  Uptime Status Configurati.. N
ew

No vitusl machines were found on this server. 17 Import Virtual Machine,

8 Virtual Switch Manager for WIN-35MLITLAMDG - X Hyper-V Settings.

Bm

Virtual Switch Manager..

A Virtual Switches

I Create virtual switch

Virtual SAN Manager.

2

7 Broadcom Netktreme Gigabt ther.. <4 fditDisk.
Srosdzem 1=tktrene Cozit e & Inspect Disk.
% Global Networl Settings
(®) Stop Senice
U MAC Address Range
00-15-5-21-17-00 t 00-15-50-2. % Remove Server
© Refresh
Create v suitch View
Creates a vitual sitch that inds to the physical network adapter so that vitual H Hep

machines can access a physical network.

| checkpoints )

} Detaiis cancel Aoty
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

5. Enter a Name for your switch and click Apply.

B& Hyper-V Manager - X
File Action View Help

+=| 2@ HE

[ Hyper-V Manager = = Actions.
[ WIN-35MLITLAMDG S Mo N
Name State CPUUsage  Assigned Memory  Uptime Status Configurati.. " )
ew
No vitual machines were found on this server. B Import Virtusl Machine.
3 Virtual Switch Manager for WIN-3SMLITLAMDG - X Hyper-V Settings...
F3 Virtual Switch Manager..
| virtualSwitches | &, per 1w Virtual SAN Manager.
& New virtual network switch )
Broadcom Netxtreme Gigabit Ether. Name: wa Edit Disk.
Sroadcon NetXreme Gigabit Ether... | [New Virtual Switch ] 5 Inspect Disk.
o New Virtual Switch
Broadcom NetXtreme Gigabit ... Notes: (m) Stop Service
2 _Global Network Settings X Remove Server
§ MAC AdcressRange © Refesh
00-15-5D-21-17-00 to 00-15-5D-2.
View »
Connection type
What do you want to connect this virtual switch to? B rep
@® External network:
Broadcom NetXtreme Gigabit Ethernet ~
system to share this
] Ensble singe-root 10 virtuslizaton (SR10V)
O Internal network.
O Private network
AN
[ Enable virtual LAN identification for management operating system
2
Remove
@ SRV can orly be configured when the virtual switch s created. An external
virtual switch with SR-IOV enabled cannot be converted to an internal or private. =
| Checkpoints switch, ©)
}M.ik Cancel Aosly q
L&) Network Connections [m| X
1 .Eil » Control Panel » Metwork and Internet » MNetwork Connections v O Search Metwork Connections @
Organize « Disable this network device Diagnose this connection Rename this connection View status of this connection Change settings of this connection ~ [ 0
"'-. MNICT - MIC2 — vEthernet (Broadcom MetXtreme
o= _ Enabled "o _ Metwork cable unplugged ~ _ Gigabit Ethernet - Virtual Switch)
@2 Broadcom NetXtreme Gigabit Eth... x @7 Broadcom NetXtreme Gigabit Eth... &7 Network 2

7. Create a virtual instance.

8. Select New > Virtual Machine.

HE Hyper-V Manager - X
File Action View Help

|z B
[ Hyper-V Manager

Actions
i WIN 25 avine ” Virtual Machines
New > Virtual Machine. WIN-35MLITLAMDG -
TPUUsage  Assigned Memory  Uptime Status Configurat
Import Virtual Machine. Hard Disk. New »
o — Floppy Disk. No vitual machines were found o this senvr. % mport Vitual Machine
Virtual Switch Manager. [] Hyper-V Settings...
Virtual SAN Manager. £3 Virtual Switch Manager.
Edit Disk. #. Virtual SAN Manager.
Inspect Disk. s EditDisk.,
& Inspect Disk.
Stop Service
Remove Server =) Stop Service
Refresh X Remove Server
Vi > © Refresh
ew
View »
Hel
| H ‘ h

10
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

9. Enter the virtual instance name and click Next.

B8 Hyper-V Manager - X
File Action View Help
= nm Bm

[ Hyper-V Monager - ]
BB WIN-33MLTLAMDS Virual Mactines WIN-35MLUTLAMDG -
Name State CPUlsage  Assigned Memory  Uptime Stotus Configurat " R

No vitusl machines were found on this server. % Import Virtual Machine.

[] Hyper-V Settings.
E2 Virtual Switch Manager.
. Virtual SAN Manager.
3 New Virtual Machine Wizard x w4 EditDisk.
£ Inspect Disk..
. . (™) Stop senvce
@ Specify Name and Location X Remove Server
© Refresh
Before You Begin Choose a name and location for this irtual machine. View »
The Manager. that you use a name that helps you easiy H Hep
[ —— ident ., such as the name of the system or workload.
P — Nome: [ronem]
Confiis St You can reste 3 folder or use an existing folder to store the virtual machine. If you don' select a
G Ee foldr, the virtual machine i stored in the default flder configured for this server.
Installation Optiens [ Store the virtual machine in a different location
Summary #\ProgramDataWMarasaft\Windows yper-V\ Browse...
<previos | [ next> || Fnsh || cancel
Checkpoints ®

10. Assign memory as per the requirement and click Next.

18 Hyper-V Manager - o X
File Action View Help

= 2@ HE

Hyper-V Manager Actions
ud 2 Virtual Machines
. irtual Mact
B WIN-35MLITLAMDG WIN-35MLITLAMDG =
Name State CPUUsage  Assigned Memory  Uptime Status Configurati
New >
No vitual machines were found on this server % Import Virtual Machine..

[ Hyper-V Settings...
5 Virtual Switch Manager..
o Virtual SAN Manager

8 New Virtusl Machine Wizard x i Edit Disk.

Inspect Disk.
Stop Senice

@ Assign Memory

Remove Server

Refresh

Before You Begin Specify the amount of memary to alocate to this virtual machine. You can specify an amount from 32 View »
M through 12552912 M. To mprove performance, speafy mare than the minimum amount

Sesay eSSt recommended for the operatng syster. B Hep

Specify Generation

Startup memery:
Use Dynamic Memory for this virtual machine.

Configure Networking d " v

Connect Virtual Hard Disk @ Vhenyou as5ign 10 3 virtua machi der how you ntend to

use the virtual machine and the operating system thatit wil run.
Installation Options

Summary

<previous | [ tet> || Fnsh || cancel

11
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

11. Select the Network Switch which you have configured initially and click Next.

|8 Hyper-V Manager

- X
File Action View Help
e 2w @
5 Hyper-V Manager - . Actions
B WNIMIDG Vet i — S
Name State CPUUsage  Assigned Memory  Uptime Status Configurati.. " R
ew
No vitual machines were found on this senvr. % Import Virtual Machine...
[ Hyper-V Settings...
EE virtual Switch Manager...
e Vitual SAN Manager.
R New Virtual Machine Wizard x w4 EditDick
) Inspect Disk.
N ®) Stop Service
= Configure Networking
X RemoveServer
U Refresh
Before You Begn Each new virtual machine ndudes a netuork adapter. You can configure the network adapter to use a View >
Vil switch, o it c2n remain dsconnected.
Specfy Name and Location H Hep
Specify Generation Connection: [Not Connected ~
ssign Memory
Connect Virtual Hard Disk
Installation Options
Sunmary
<Previous Frich Cancel
Checkpoints )

12
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

12. Select the image (VHD) by selecting the option, Use an existing virtual Hard disk and select the
location where your VHD image is stored (In case of MX-ONE Unzip the Hyper-V Image and select

13
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

the Virtual Hard Disk ).

B& Hyper-V Manager
File Action View Help

L 2Nk
[ Hyper-V Manager
B WIN-35MLITLAMDG PRI LTS
Name State CPUUsage  Assigned Memory  Uptime Status Configurati..
No virtual machines were found on this server.
B new Virtual Machine Wizard X
@ Connect Virtual Hard Disk
Before You Begin A virtual machine requires storage s that you can install an operating system. You can spedify the
P — storage now or configure it later by mocifying the virtual machine’s properties.
Specify Generation () Create a virtual hard disk
P v Use this option to create @ VHDX dynamically expanding virtual hard disk.
Configure Networking Mame:  |MX-ONE-LIM1.vhdx
tion: |C:\Users\Public\Documents\Hyper-V\irtual Hard Disks\ Browse..
Summary
Size: 127 GB (Maximum: 64 TB)
(®) Use an existing virtual hard disk
Use this option to attach an existing virtual hard disk, either VHD or VHDX format.
() Attach a virtual hard disk later
Use this option to skip this step now and attach an existing virtual hard disk later.
<previous | [ Next> || Fish || cancel
Fhormninte =
B8 Hyper-v Manager
File Action View Help
L )
[ Hyper-V Manager
g WIN-35MLITLAMDG Virtual Machines
Name State CPUUsage  Assigned Memory  Uptime Status Configurati.
No vitual machines were found on this server.
3 open kS
« « 4 | |s> ThisPC 5 Desktop > HyperV-Image-MX-ONE_7.1.5p0.hf0.rc10 > Virtual Hard Disks v ©  Search Virtual Hard Disks P
Organize * Mew folder -~ O @
Name Date modified Type Size
# Quick access
= MX-ONE_7.1.5p0.af0.rc10 1/28/2019 10:46 AM  Hard Disk ImageF... 12,161,024 ...
I Desktop » el g =
& Downloads
Documents *
= Pictures »
Virtual hard disks
[& Microsoft Manageme
[ This PC
Local Disk (C:)
¥ Network
File name: | MX-ONE_7.1.5p0.hf0.rc10 v| Virtual hard disk files v
Checkooints ! ~

14
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CHAPTER 6

INSTALLING MX-ONE ON HYPER-V

BE HyperV Manager
File Action View Help

= | 7|

R Hyper-v Manager

Bl WIN-35MLITLAMDG RN TETE
Name State CPUUsage  Assigned} :mory  Uptime Status Configurati..
No virtual machines were found on this server
[ New Virtual Machine Wizard
=] Completing the New Virtual Machine Wizard
Before You Begin You have successfuly completed the New Virtual Machine Wizard. You are about to create the
P — following virtual machine.
Spedfy Generation Desaription:
Pesign Memory Name: MX-ONE-LIM1
e Generation: Generation 1
Memory: 8000 MB
Connect Virtual Hard Disk Network:  Broadcom NetXireme Gigabit Ethernet - Virtual Switch
| summary  [EEESEISEERT \Desktop\ypery-Image-MX-ONE 7. 1.5p0.hfD.rc 10Wirtual Hard
< >
To create the virtual machine and dese the wizard, dick Finish.
<Previous Next > Fsh | | Cancel
[N =
B& Hyper-v Manager
File Action View Help
= nmH
[ Hyper-V Manager
EF WIN-Q2LO5K123T U
Name State CPUUsage  Assigned Memory  Uptime Status Configurati...
B mxoNELM Running 0% 2000 MB 0001:06 20
£ Settings for MX-ONE-LIM1 on WIN-QLOSK123JT -
| MX-ONE-LIMT MR-
#_Hardware ~ | B AddHardware
B 505 You can use this setting to add devices to your virtual machine.
Boot from €D Select the devices you want to add and dick the Add button.
@ seaity 5C31 Contraller
Key Storage Drive disabled Netuork Adapter
W Memory RemoteFX 30 Yidea Adapter
8000 ME Legacy Network Adapter
[ Processor Fibre: Channel Adapter
1 Virtual processor
El [0 10E Controler Add
= Hard Drive
MX-ONE_7. 1.sp0. hf.rc10. =
Checkpoints /8 10E Controller 1 (
() DVD Drive
None
& scst controller
1 Metwork Adapter
New Virtual Switch
@ com1
Mone
@ comz
None
[ Diskette Drive
None
# Management
Name
MX-ONE-LIM1
Integration Services
Some services offered
(B Checkpoints
Production
& Smart Paging File Location
C:\ProgramDataMicrosoft v
‘ MX-ONE-LIM1
| o [
— s
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

14. Start the machine and install MX-ONE setup as shown in the following figures.

H

File Action View Help
es 20 BE 2 WX-ONE-LIMT an WIN-35MLITLAMDG - Virtual Machine Connection - o X
File Action Media Clipboard View Help
H Hyper-V Manzger ®0 B Actions
" Virtual Ma £ 0 n R
i WIN-35MLITLAMDG » e e

Neme Configurati.
§ weon GNU GRUB wersion 2.02 i New

Use the t and § keys to select which entry is highlighted.
Press enter to boot the selected 03, ‘e’ to edit the commands
before booting or “c’ for a command-line.

The highlighted entry will be executed automatically in 3s.

Status: Running =@

File Action View Help

L ANl ol 7 icy
H -V M,
Eﬁ;p\/vﬂw-a;:;?;aﬁ File Action Media Clipboard View Help
B D@0 uwf
MX-ONE Telephony System Setup, Versi

£ MXONE on WIN-QSLO5K123JT - Virtual Machine Connection -

MX-ONE Initial Setup
Welcome to MX-ONE Telephony System Setup

You have to configure your server before starting
the Telephony System.
Do you want to configure your server now?

<Hho >
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% Import Virtual Mz
7 Hyper-V Settings
HE Virtual Switch Mz
s Virtual SAN Man:
Edit Disk.
& Inspect Disk..
) Stop Service
X Remove Server
© Refresh

View
H Hep
MX-ONE-LIM1
9 Cennect...
F9 settings..
®) Tum Off...
® ShutDown.

O Ssove
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CHAPTER 6

File Action View Help

INSTALLING MX-ONE ON HYPER-V

L ARallzc (N 7 oy
T Hyper-V Manager
B wiN-QoLoskizaT| File Acti

B3 \IXONE on WIN-GSLO5K123)T - Virtual Machine Connection
on Media Clipboard View Help

OO |n |k

MX¥-DNE Initial Setup
Successful restart of netuork
service

Missing servers will not be included if you choose to continue

They can be added later

Wait for expected server(s) to appear

Hew server data file(s) received from:
mxone-1inl.mitel.con

[Press ¢ to continue

Status: Running

File Action View Help

== 5 BE

[ Hyper-V Manager
i WIN-QoLoSk123yT| e Action Media Clipboard View Help
Ba D@0 u |k

1011 mxone-linl.mitel.com

B MXONE on WIN-QILOSK123IT - Virtual Machine Connection

[Executing:

cassandra_sn createTables, schena file=-optseri_sns17.1.8.0. 1 etcsmxone_cql.schema
ok

[Execut ing

-opt -mxone_install-7.1.0.0. 1 target-install_scripts/serviceNode “insertConf igDataInDB”

Inserting Alarm Conf iguration into database
Inserting default domain data inte database

23
Executing "start” in all servers
Ack from mxone-liml.mitel.con
Wait for 1 answers.
Ansuer received from:
1011 mxone-linl.mitel.com

Distribute server data to other servers

jok

ait for LIM(<) to start

Max wait time: 11 minutes

[Btatus InitialStart0fSystem occured
Initial Start Of System Successful
The MXONE system is started ol

Executing config_mirror
fconf ig_nirror ol

T T e S B B R e T
]

*
# OBSERVE!? To get correct group membership logout and in again. #

] £
SR SR I SR R A R R R S SR R R

Installing addon softuware

Installing MX-ONE Service Node Manager - please wait ...

Starting silent installation of mxone_snm rpm
[Follow progress by opening another shell and type:

tail —f —n B var.log/mxone uebserver applicat i

fcreated symlink from setcssystendssystensmulti-user.target .uants/mxone_
Installation of MX-OME Service Mode Manmager is finished.
jiebserver will now be re-started. This may take a uhile.

See progress i
opt~ jboss standalane-logserver . log

log.. log

[Finished. Sce log file -varslog mxonecuebserver application log.log for details.

Updating serverData.conf

Installation finished successfully

1inux—Z44m:~ #

oss.service to susrslibssystend systemsmxone_jboss.service.
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Actions
WIN-QSLOSK123/T

New

% Impart Virtual Machine..

Hyper-V Settings.

8 Virtual Switch Manager..

Edit Disk...
Inspect Disk.
=) Stop Senvice
¥ Remove Server
© Refresh

View

H Hep

48 Connect...
E? Settings...
=) Tum Off...
@© shut Down...
© save

1 Pause

1> Reset

By Checkpoint

B Move..

I Export.

T Rename..

#8 Encble Replication.

H Hep

Virtual SAN Manager...
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CHAPTER 7 INSTALLING MX-ONE KVM, SUSE LINUX

Installing MX-ONE KVM, SuSE Linux

To install MX-ONE on the Kernel-based Virtual Machine (KVM) on the SUSE Linux platform, follow these
steps:

Download the MX-ONE ISO image (Recovery image) from the MX-ONE repository.

Make a bootable USB and load it with the Recovery image to install OS with KVM capability.

Run the USB and select option 3 (KVM install).

Install the KVM image and system is restored with SUSE Linux installed.

1.
2,
3.
4,
5.

Enter the root login credentials.

Tue Apr 9 08:31:21 2015 from 10.210.30.207

6. Using the Yast utility, enter IP address, Gateway, DNS and subnet Mask to the system. For more infor-
mation see,
https://www.suse.com/documentation/sled11/book_sle admin/index.html?page=/documentation/sle
d11/book_sle admin/data/sec_basicnet_yast.html.

999999999399999IIIIIIIIIIIIIAIIAAIITITITAIITIIIATIL

x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x

7. Using the configured IP address login to the terminal using putty.

8. For the installation of KVM over SUSE download the. gcow2 and .xml files from the package reposi-
tory.
9. Check if 1ibvirtd is running or not, else start it: sudo systemctl status libvirtd

libvirtd.service - Virtualization daemon Loaded: loaded
(/usr/lib/systemd/system/libvirtd.service; enabled; vendor preset:
enabled) Active: active (running) since Mon 2019-04-08 14:38:40 CEST;
22h ago Docs: man:libvirtd(8) https://libvirt.org Main PID:

18
28/1531-ANF 901 14 Uen D2 2019-11-07


ftp:/10.105.64.17/git/Release/refs/tags/mx7.1.0.0.27/iso/
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21036 (libvirtd) Tasks: 18 (limit: 32768) CGroup:
/system.slice/libvirtd.service 2221036 /usr/sbin/libvirtd -listen

10. Create a virtual machine, enter virt-clone --original-xml Virtu-
al Image-MX-ONE 7.0.spO.hf2.rc5.xml --name <your system name> --file
/local/images/<your system name>.gcow2

Forexample,virt-clone --original-xml Virtual Image-MX-ONE 7.1.sp0.hf0.rc26.xml
--name MX-ONE --file /local/MX-ONE.gcow2

NOTE: Keep the qcow2 and xml under the local folder. Edit (vi) the xml file and change the default
path from /kvm/images to /local where you have saved the image file.

11. When the kvm image installation is complete, create a network bridge and map it to the etho0 that you
are using so that KVM can access it.

12. To add a new network bridge device on VM Host Server with brct1, follow these steps:

a. Log in as root on the VM Host Server where you want to create a new network bridge.

b. Choose a name for the new bridge-VIRBR_TEST in our example- and run root # brctl
addbr VIRBR TEST.

c. Check if the bridge was created on VM Host Server root # brctl show

bridge name bridge id STP enabled interfacesbr0
8000.e06995ec09%9e8 no ethOvirbr0 8000.525400b37ec9
yes virbrO-nicvirbr test 8000.000000000000 no

NOTE: virbr test is listed, but not associated with any physical network interface
d. Add a network interface to the bridge using root # brctl addif ethl command.

NOTE: Network interface must not be already in use. This is because you can only enslave a
network interface that is not yet used by other network bridge.

e. Optionally, enable STP using root # brctl stp VIRBR TEST on command.

For more information, see https://www.suse.com/documentation/sles-12/book_virt/data/libvirt -
networks_bridged.html.

brctl showbridge name bridge id STP enabled
interfacesbr0 8000.28b9d9%¢09f41 no ethO
vnet0

13. To start your virtual machine, install Mobaxterm (GUI or X server support). See htips:/mobax-
term.mobatek.net/download-home-edition.html

14. Run KVM machine and run virt-manageron the command line.

B root@linux-2dnue - x
Terminal  Sessions  View Xserver Tools Games Settings Macios Help

ok % % oA ® E Y E 8 s 0 %

Sesson  Servers  Toos  Games  Ses View spit M Q Packsges Settngs  Help Xserver Bt

=

&

A Macros & Tools
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15. This gives you the virtual manager access through which you, start, stop, or change the MX-ONE
deployed KVM and install it.

" Virtual Machine Manager@linux-2drw - x
Flle Edit View Help
Open o -~
v QEMUAVM
R MX-ONE on QEMU/KVM@linux-2drw - ¢

File Virtual Machine View Send Key

d - B

g
# OBSERUE!? To get correct group membership logout and in again. #

L L
HREE R R R R R R SRR R
Installing addon sof tuare

Installing MX-ONE Service Node Manager - please wait ...

Starting silent installation of mxone_snm rpm
Follow progress by opening another shell and
“n @ /vax‘/lugmxuneluebseruer/aypllcatlun log. log

eated synlink from setc systend-systenmulti-user.target.uants mxone_jboss.service to susrs1ibssystend systensmxone_jboss .seru
ice
Installation of MX-ONE Service Node Manager is finished.
Uebserver will now be re-started. This may take a uhile.
See progress in:
sopt~ jbasssstandalones logsserver. lag
Finished. See log file svarslogsmxone uchserver-application_lag.log for details.
Updating serverData.conf

Installation finished successfully

Linux-8nBy:” # bretl show

If ’brctl” is mot a typo you can use command-not-found to lookup the package that contains it, like this:
cnf bretl

Linux-8nBy:~ # ifconfig -a

ethd

inet addr:10.211. ‘31 3‘! Btast 10.211.91.255 Mask:255.255.255.0
incth addr: £c80 829,64 Scope :Link

UP BROADCAST nunnmr nUansr MTU:1508 Metricil

RX packets 4158 errors:0 dropped 11967 overruns:® frame:0

X packets:147 errors:@ dropped: averruns:@ carrier:g
collisions:0 txqueuelen:1080

RX bytes:338988 (331.0 Kb) TX bytes:23457 (22.9 Kb}

Link encay Lm:al Lnnpbm:k
inct add:

inet6 adtlr 1/123 Sl:up Host

UP LOOPBACK RLINN]NG MTU:65536 Metric:1

:0 carrier:0
collisions:0 txqueuelen:1000
RX butes:15399032 (14.6 Mb) TX bytes:15399032 (14.6 Mb)

Linux-6nBy:~ #

16. Executables are stored in /usr/libexe.
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28/1531-ANF 901 14 Uen D2 2019-11-07



CREATING A VM BY IMPORTING AN MX-ONE acow2 IMAGE
CHAPTER 8 INSTALLING MX-ONE KVM ON REDHAT-LINUX

Installing MX-ONE KVM on Redhat-Linux

To install Kernel-based Virtual Machine (KVM) on Redhat-Linux, follow these steps:
1. Install the Redhat-7.6 OS through a bootable pen-drive or any other external media.
2. Create a bridge interface; for example, i fcfg-br0.

NOTE: For configuration details, see Network Bridge.

3. Copy the Mx-0ONE .gcow?2 image to the host machine to continue installation. See Creating a VM by
Importing an MX-ONE qcow?2 Image for installation instructions.

Creating a VM by Importing an MX-ONE gcow2 Image

To create a virtual machine (VM) by importing an MX-ONE gcow?2 image, follow these steps:
1. Log in to your machine as root user.
2. Navigate to the directory of the installation files previously downloaded.

NOTE: Create a backup copy of the image file.
3. Move the image file to the directory where you want to place the virtual machine.

4. Start the Virtual Manager and click Create a new virtual machine
=

5. Select Import existing disk image and click Forward. See Create a new virtual machine screen for
details.

Figure 8.1: Create a new virtual machine screen

m Create a new virtual machine

Connection: QEMU/KVM

Choose how you would like to install the operating system
Local install media (ISO image or CDROM)
Network Install (HTTP, FTP, or NFS)
Network Boot (PXE)

o) Import existing disk image

w Architecture options

Architecture: | x86_64 »

Cancel E Forward

6. Click Browse and navigate to the path of the image file.

7. Select the image file and select the operating system type and version from the following fields and
click Forward. See Selecting the OS and version for details.

- OS type
— Version

21
28/1531-ANF 901 14 Uen D2 2019-11-07


https://access.redhat.com/documentation/en-us/red_hat_enterprise_linux/6/html/deployment_guide/s2-networkscripts-interfaces_network-bridge

CREATING A VM BY IMPORTING AN MX-ONE acow2 IMAGE
INSTALLING MX-ONE KVM ON REDHAT-LINUX

CHAPTER 8

m Create a new virtual machine

Selecting the OS and version

8. Complete the following fields and click Forward (see Memory and CPU settings for details):

- Memory (RAM)
- CPUs

Provide the existing storage path:
‘ flocalfimages/new_machine.qcow2 Browse... ‘
Choose an operating system type and version
0S type: | Linux -
\ersion: | SUSE Linux Enterprise ¢ | «
Cancel ‘ ‘ Back | ! Forward ‘

NOTE: For the memory and CPU settings, specify values that match your system. For the purposes
of this procedure, the values 6 GB RAM (6144 MB) and 2 CPUs are specified.

Figure 8.2: Memory and CPU settings
m Create a new virtual machine

Choose Memory and CPU settings

Memory (RAM): | 144 ] [

Up to 96255 MIB available on the host

CPUs: | 2| +

Up to 12 available

i Cancel ‘ Back
| @

9. Click Finish. See Creating a VM for details.
The details of the VM to be created are displayed.

Forward
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Figure 8.3: Creating a VM

m Create a new virtual machine

Ready to begin the installation

Name:

new_machine|

0S: SUSE Linux Enterprise Server 12 SP4

Install: Import existing OS image
Memory: 6144 MiB

Storage: /local/images/new_machine.qcow2

CPUs: 2

Iz Customize configuration before install

» Network selection

Cancel

‘ Back

Finish

10. Click Begin Installation. The virtual machine is created. See Begin Installation for details.

</ Begin Installation

T;‘__ Overview

& CPUs MNarme: new_machine
&5 Memory uuID: 5b8a0ad2-ag3b-41c8-baBe-5e56bf8c2533
& Boot Options Status: B shutoff (Shut Down)
L Virtlo Disk 1
=V 2 Title:
B NIC :80:02:3d _
Description:

[#] Tablet

! Display Spice
HF Sound ich6

= Console

;;3 Channel gemu-ga Hype
£~ Channel spice

I video qx Emulator:  jusr/bin/gemu-kvm
= Firmware:
B8 controller use 0 ‘ BIOS
) USB Redirector 1 ipset: -
@ i Chipset ‘ — ‘

@ USB Redirector 2
é%i} RNG jdevjurandom

Figure 8.4: Begin Installation

!J Cancel Installation

Basic Details

Hypervisor Details

rvisor: KVM

Architecture: x86_64

11. Use the Mobaxterm (GUI or X server support). to open a virtual manager session. See Virtual Machine

Manager for details.
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Figure 8.5: Virtual Machine Manager

hd
¥ Virtual Machine Manager@localhost.localdomain = O X

File Edit View Help

(™ Bl Open , n ~
Name v CPU usage
v QEMU/KVM

“ MXONE-KVM-REDHAT
Running |
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Installing and Configuring MX-ONE

With all the virtual MX-ONE servers in place and configured, it is time to build a PBX out of them. The
procedure of setting up the system is the same as for physical MX-ONE servers loaded with turnkey
installations. The difference lays in the access of the MX-ONE servers that is done through the vSphere
client.

For more details see INSTALLING AND CONFIGURING MIVOICE MX-ONE.
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